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1. Dynamic Report Generation

* Word format report can automatically be generated for selected input & output data
(figures, tables, graphs, and text).

* Using “Dynamic Report Regenerator” function, changes of a model file are automatically
updated in the report.

* User defined report format can be used and saved.

Tools > Dynamic Report Generator
Tools > Dynamic Report Image

Tools > Dynamic Report Auto Generation

(optional)
Register data Generate areport III; Modify model data Re-generation

#*Registerimages, +Generate a report in +*Modify model data. s Automatic re-
tables, and graphs to MS Word format. «Re-performanalysis generation of the
insertinto the report. sInsertdata by Drag & and design. reportwith updated

*Registered data can Drop from the Report analysis results.
be verified in the Tree.

ReportTree.

Dynamic Report image
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Procedure for Dynamic Report Generation

Step 1. Open midas Civil model file.

Step 2. Register contents(image, table, chart, summary...) to enter them in the report.
Registered contents are displayed in the Report Tree.

Step 3. Open a new report.

Step 4. Enter the contents by Drag & Drop from report tree.

Step 5. Modify the report file if required.
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Open a new report

e L e

Insert contents by Drag & Drop
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Procedure for Auto Regeneration

If there are any changes in the model file, we can automatically update the pre-generated
report.

Step 1. Modify a model file if required.
Step 2. Open the pre-generated report.
Step 3. Re-generate the report.

Step 4. Check the updated contents

T
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Regeneration
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Check the updated contents
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2. Addition of Concurrent Reaction for BD37-01 Vehicle Load

* “Concurrent Reactions” can now be calculated for BD37-01 Vehicle load.
e Generally, the reactions or member forces calculated due to moving load analysis are the

Max/Min values for each reaction values (ex. FX, FY, ... etc.). However, for the support nodes

included in the Concurrent Reaction Group, the concurrent reactions are calculated.

Result > Result table > Concurrent (Max/Min) Reaction

Define Standard Yehicular Load

Define Concurrent Reaction Group
Standard Narw
[mj.,'»‘ Standecd Losd _'J Mode Group Selected Group
Cross Beaml Reaction
| Veheodar Load Properbes - Cross Beamz
Cross Beam3
Wehicular Load Name - |He Cross Beam4 - |
. Lo Tyos l’ﬁ ll gﬁoss Beam5
Cross Beams
< |
<] 13 % h
HB Losding !..--L---..-_-.--!-..-.‘
Dy T Da, Do, DaDsDe 1 Dro
~ Remowve Concurrent Reackion Group
am——aa f AR e e , "
~ . o
BD37-01 Vehicle

Concurrent Reaction Group

[T el Gt Result-{Concurrent(Max/Min) Reaction] |
Loexd Case

oo Node 1
FX Y FI Mx MY L4 FX FyY
A Rege 00 020 020 I (i) I onvm) | onm) | 08 I ) l
| 111111 Reaction

Concurrent Reaction Result Table
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3. Pressure Type of Beam Loads

e “Uniform Pressure” and “Trapezoidal Pressure” type of Line Beam Loads and Element

Beam Loads have been implemented to consider the width of beam elements when

entering wind loads.

e This feature is useful to assign wind loads to the tapered girders (ex. longitudinal girders in

bri

dges).

Loads > Element Beam Loads

Loads > Line Beam Loads

—Load Type

ILIniFnrm Pressure

Pressure

o
]

Ha

||v' Additional H From Top |

Distancelm)

I-End |1.2

JEnd |U r

Direction IanaI W vl
Projection : © ¥es  F No
—Walue

(* Relative { Absolute

x1 |o o |3

w2 |1 lu}

%3 |0 lu}

x4 |0 1

Unit:  kMim?2

Y ﬂpw-’j\h gose. |

Uniform Pressure type

Assign a beam load as a pressure load
considering the beam width

—Load Type
Trapezoidal Pressure ;I |

PFBSSU;EZ}%
e
M1 J": -

_|'|7 Additional H Fram Top |

Distancedm)

I-End |1 g
JEnd |'3' r

Direckion ILDEEI| W VI
Praojection : CVes Mo
~Walue
(¢ Relative (" Absolute
x1 |0 Pl
wz |0 Pz 1.5
%3 [0 P3 2.5
x4 |0 P4 |5
Unit:  kMfm2
Close

Apply
e S —— e

Trapezoidal Pressure type

Additional H

to consider the additional height of the structures
which was not included in the modeling (ex. guard fence)

MipAS
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4. Improved Eccentricity Option in the Element Beam Load and Line Beam Load

e Eccentricity can be entered by the following 2 methods: 1) from the centroid, and 2) from
the offset point.

¢ In the previous version, the eccentricity was entered only from the centroid. In case of the

tapered section, beam loads with eccentricity can be easily entered from the offset point.

Loads > Element Beam Loads

Loads > Line Beam Loads

|Line Beam Loads j J ] P

Load Case Name ¥ I e €

|2nd Dead ﬂ —a—— — s

& e

Load Group Mame VAN

|2nd Dead =l III Mode

Options

(¢ Add ( Replace  Delete

I | I |
Load Tvpe -
1P from Offset from Centroid
|LIn|Fc-rm Loads ﬂ

w

m Two methods to enter the eccentricity

NN
A

EN

Element Selection

|On the loading line ﬂ

[v Eccentricity
f* Centroid " OFfset

Direckion : Local z -

Distancelm)
IEnd [0,
1End ,7 r Enter the eccentricity from Offset (nodal position)
L NPT — for the tapered sections
____dl N i b T p
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5. Improved India Standard section DB

e New sections (Box, Pipe, and Angle) have been implemented in IS, 1S1161, and 1S808

section DB.

Model > Properties > Section

DEAJe | Vdue | SAC | Camdirad | Tepered | Conuasin

Section © || | =

Name | r Vs

Sect Name

H
8
w
"l
C
L4
v Connider Shuar Dwlarmatian
Ofeat | Cooter-Conter
Charge Osst
Btaw Calulabon Fesaits | O Cancwl | Aoty

Box Section SHS

fSan Daty

DEAser | Vdue | SAC | Camdirad | Tupered | Conuasin
Saction © || llo o ]
oo -

Suct Name -
o |
w
v
¥ Connidet Shuar Dularmatian
Ofeat - Cooter-Cenar
Charge Ot
aw Calealation P st | ¥ Canew } Apply

Pipe Section NB

DEMJaer | Ve | SAC | Camdirad | Tependd | Conuosin

Sacthon O [ I 5
o= ,

Neome JRATS 0G5

" Vs - 08

Sect Nanw | -

AT
£ (hed [
N B

¥ Considet Shuasr Dularmatian,

Ofeat © Cooter-Center

Charge O

Staw Calealation P | O Cancwl | Sopy

Box Section RHS

W | vk | a0 ontwed | Tagered | Congosee |
tachn | I a0

Argie
Syws T8 2000y " User

W Oaviader Shewr Defirvnston

Cttemt - Curvwe Cortw

Crange Off st ..

Shoee Cacuiation Py | o | Carewt | Aoty
Angle Section Data
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1. Mander Model in Inelastic Material Properties

e Mander Model has been added to model the behavior of concrete confined with steel
stirrups.

e The menu name, Fiber Material Properties, has been changed to Inelastic Material
Properties.

Model > Properties > Inelastic Material Properties

Inelastic Material Model

X

Name : {Concrete
Makerial Type : | Concrete |
Hysteresis Model : [Mander Model Lj
Concrete Type Saction & Confinement Rebar Type
" Unconfined Concrete : Cover Concrete (+ Rectangular " Groular : Hoop Confinement Steel
(s Confined Concrete : Core Concrete " User Defined (" Cireular 1 Spetal Confinement Steel
Impoet Reference Material & Section Data | Section Data | Rebar Data

Confinement. Effectiveness Coefficient, ke

Acc : Area of Effective Concrete Core ™ |1800000,0000 mm?
Az : Total Area of Effectively Confined Core Concrete

Materia(C40/50) and section() data are only referred to during a file import, Modified
material{C40/S0) and section() data will not be updated. Re-importing a file is not required.

Unconfined Concrete Data
{820000.
fico' : Unconfinad Concrete Strenath [~ }40.0000 Njmm? = 0000 L5, L’
o onfied C ool r oz ko = Ae § (Ac (1-cc)) = Ae | Acc = I~ jo.4555%6 <1.0
Corresponding to feo' (qenerally £co=0.002 can be assumed) The Effective Lateral Confining Stress on the Concrete
Ec : Elastic Modulus of Concrete The eife{ [T] Material...
[Mander et al ~| [1ezz.7766 N2 inthey, i i i i
etal. o @ Time Dependent Material(Creep/Shrinkage) Function...
iy’ ﬂ Tirme Dependent Material{Creep/Shrinkage). ..
ft' : Tensile Strenath of Concrete Time Dependent Material{Comp. Strength)...
Confined |
+ Streq
. Ef Change Element Dependent Material Property. ..
e : Straf
d Plaskic Material...
A
~ I Section...
i J / Comfined Concrvse E Section Stiffness Scale Factor,..
b p . Unconfinad
B ) WS, Concrete f;. Tapered Section Group...
E: : : »\»ul‘vu-_' for E: Ihickness...
= R =" pr Congrew
- (% 15| weall stiffress Seale Factor...
.'J &, 2, CI.. £, H Inelastic Hinge Properties. ..
f‘ Compressive S, £, H Inelastic Hinges. ..
Elustic modulus of Concrete E = %000 fr MPs “& (EEUD oo
lstic m s = 5,000,/ M IIt‘Mt'IP - I
| Inelastic Material Properties. ..
SR 4
Tensile Strength of Concrene =062, N N L N
& L f p fa MPa I:‘ Fiber Division of Section
Tensile Strain of Conorone £ === = i
s ot E E Material Table. .. Chri+Al+L
T Tl g, et AT
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2. Improved MINEGOTTO-PINTO Steel Model

e In MINEGOTTO-PINTO steel model, the equation for calculating the plastic strain, ¢ , has

been changed in order to enhance the convergence performance.

U Previous version U New version

Element 2, Ry(rad/mm)-My(N-mm)

& — & & — &
Ae>0 ; §=—mx 20 Ae>0 ; & =—mx 0
Ey— & &
§ _ 0 r 5 _ y
Ac <0 5 —M A 0 : €0~ &nin
H 2 — &< X 52 -
&y — & gy
Inelastic Material Model @ Inelastic Material Model rZI
Name: [P sTEEL Name : [MP STEEL
Material Type : |steel ~| Material Type : [Steel ~]
Hysteresis Model : |Menegatto-Pinto Madel | Hysteresis Model :  |Menegotto-Pinto Madel ~|
O ,(tension) O ,(tension)
fy i l:{__- —7]
--------- i  bE Z] E o i  bE E
I ke
~ Loy
L [{ tyl‘ €
vt (tension) N (te.n_s_ion)
----------------- i “'_--_------
Skeleton Curve Skeleton Curve
fy 295 KWm:  Ro |20 v [ N/mm:  Ro [&
E [z00000  Ky/m2 a1 185 < E riu_ ’N.me :",,‘Esm\_ i
3 '\ Selan Al an i K b O g
WO 8 il SR e PSS il Nl =

Element 2, Ry(rad/mm)-My(N:mm)

o 3.0
8.00e2 &.00e2
€.00e8 €.00e2
40088 4.00e2
2.00e8
0.00e+00 0.00e+000
'3.00e =2.00e®
4.00e8 =4-00e8
€.00et —5; 000
.00e2 Srion
E: -qfnc.-c’ '-2.80e=4  ~1.00e=8  $.00e-% 1.50e=§ 2.80e=4 3.30e~% 4.09e4. Ros=s 00e=4¢ "5.00e-3 3.80-4 2.80e%4 3.30e4
—————————— TIME STEPS- ----SUBSTEPS- --ITERATIONS- —==————————-TIME STEPS- ----SUBSTEPS- --ITERATIONS-
2950 / 2950 2961 7578 2950 / 2950 2958 7496

MipAS
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3. Improved Pushover Analysis Result

e Pushover analysis results have been graphically improved in order to prevent the

user’s confusion.

¢ In FEMA and Eurocode type hinge, the hinge status of “C” point and “D” point is now
displayed separately. In the previous version, the hinge status of “C,D” was displayed

after the C point.

Result > Deformations > Deformed Shape
Design > Pushover Analysis > Pushover Hinge Status Result
Design > Pushover Analysis > Pushover Hinge Result Table > Beam Summary
e r————— 5 e ———-— - i
s LR ARy Sy vy .‘AJL_i-..A,*A.““ —— . uJ
New version
Linear
Pushover Hinge Status Result
Slen Detorm Force P Detonn e G oen o€ Amay
;'_m".n ARG ET0 . DOT6A008  GROSTRTIONG | 3 CoRee000 | CP
| 40 1 2000 MBS 670 l’!o&‘lmbl. 3 0000 AP
l '4" 4 26000 umw 4 eesa. 003 GA5T671 016 1 ee00 Failurz |
[ ENnedn WM A0Te08) RISTRN 04 1 Saheec0 | Y Faiture 1
] us_ sM mm-’ mmu OBO5TST N6 1 367 ae001 o Failurz
i 44 SO0 BUYIIM G GMe00) BAOSTETI D16 | %600 A Failur
i m Se1be0n MO ua-m AL ORE Failure || Fiestc Ontam | e Surt
AL SSTG0) WININ  RNIIe00) WRISTRNS 006 1 4O ee001 Failure
D e semwady W) S100e00) ) 0BOSTEI D16 141 heel) { Failure o sigociicoctiba)
I 4B 1BIeO03  ODO0) 1 48he.002] BAGSTEN D14 30436001 A Failure S08te00) SROSPITI OV
i 48 119000 000D 1 160w.003 | 0BSTGT D16 3 MIwe001 Faire Il oo o ‘sansren 014
3 S3telmd 3N M A347e-000 BNOETS 04
Previous version 1 Ad0el03 M e 00  WEOSTITY 04
e Adtel 500\ S0040-000  MSOETHY D14
16 A9teln 14 1120e000  SOOOTEN 04
I SSKelon 0 $108e 000 BROOIYNY N4
AL IR R L Lo 11580000 WNOLTEN D04
51 e 20 11500000 W0GIS 04
New version
Beam Summary Table
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1. Addition of EUROCODE PSC Design

Prestressed box girder design as per EUROCODE 2-2:05 has been added.

The following limit states are verified:

* Ultimate Bending Resistance — Clause 6.1

* Shear Resistance — Clause 6.2

* Torsional Resistance — Clause 6.3

* Crack Width Calculation and Control — Clause 7.3

* Stress Limitations for Pre stressing Tendons — Clause 7.2

* Stress limits for concrete at service and Construction Stages — Clause 7.2

* Principal stresses for pre stressing Steels — Clause 7.1

Graphical results, tabular output, and design reports are provided in Microsoft Excel format.

Load combination to Eurocode has also been added.

Exposure class for Top and Bottom surfaces.

FrrenniFam's

Design > PSC Design > PSC Design

T R -

it

Elem Situiationg

- i

11666E BEET
116666 BEET
11B6EE BEET
116666 BEET
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16666 BEET

319078 5577
319078 5677
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318078 5677
318078 5677

367 0833
-178.6417
-178.6417
-178.6417
A78ET

olLCB2 Paeralstent & T -
LBz Perslstent & T - 1 G666 BEGT 318078 5677 S1TE AT
Peralstent & T - 16666 BEGT 318078 5677 <78 AT

alirmn Baman -t s e L - Anen
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